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1 Introduction 

This document describes the changes and improvements since Productionserver 23.01 Build 15094.  

The update to version 23.10 contains new features, improvements and enhancements of existing modules and 

features, as well as bugfixes. 

In addition to applications for Commercial Printing, this document also includes some innovations for  

Industrial Productionserver products. 

For each modification it is stated if it is a new feature, an improvement of an existing module/feature or a 

bugfix: 

NEW FEATURE: a new feature 

NEW: an innovation/improvement of an already existing feature 

BUGFIX: a bugfix 

 

Note: All customers who had a valid Value Pack on effective date November 08th 2023 can update to ver-
sion 23.10 free of charge.  

Please note that if you upgrade from version 22 or earlier, you must contact our Customer Service Team 
via cs@colorgate.com to upgrade your license before you will be able to run the new version. 

Please also note that as of version 22, Microsoft Windows 8.1 and Microsoft Windows Server 2012 are no longer 

supported. 

 

More information  

Further information about version 23.10 can also be found on the website: www.colorgate.com  

If you wish to get information about improvements and bugfixes of previous versions, you can find the corre-

sponding Release Notes in our Service & Support area (please note that you have to be registered and logged in 

as a user to access them):  

https://www.colorgate.com/support/en/download 

 
 
 
 
 
  

mailto:cs@colorgate.com
https://www.colorgate.com/
https://www.colorgate.com/support/en/download


 

 

 

 

Releases Notes 23.10 Build 16034 - Page 4 of 26 New Drivers 

2 New Drivers 

2.1 Printer Drivers 

Manufacturer Device name 
   

Canon Canon Colorado M-Series 

Canon iPF GP-2000 

Canon iPF GP-4000 

Canon iPF GP-520 

Canon iPF GP-540 

Cat 2 

Cat 1 

Cat 1 

Cat 1 

Cat 1 

  

FUJIFILM Acuity Prime Hybrid Cat 2   

GuangZhou 

ChunYuQiuFeng 

CF-JD-PB1016 

CF-JD-PB1810 

CF-JD-PB2513 

CF-JD-PB3220 

CF-JD-SinglePass 

CF-JD-YZ2510JJ 

CF-RY-PB1016 

CF-RY-PB1810 

CF-RY-PB2513 

CF-RY-PB3220 

Cat 1 

Cat 1 

Cat 1 

Cat 1 

Cat 1 

Cat 1 

Cat 1 

Cat 1 

Cat 1 

Cat 1 

  

JSW JSW QR3200K Cat 2   

Kornit Kornit Atlas MAX Plus Cat 2   

Mimaki Mimaki TxF150-75 

Mimaki TxF300-75 

Cat 1 

Cat 1 

  

Ricoh Ricoh Ri 1000X 

Ricoh Ri 4000 

Cat 1 

Cat 1 
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Roland Roland LG-300 

Roland LG-540 

Roland LG-640 

Roland MG-300 

Roland MG-640 

Roland UG-641 

Roland UG-642 

Cat 2 

Cat 2 

Cat 2 

Cat 2 

Cat 2 

Cat 1 

Cat 1 

  

SignMaker SignMaker Dominator 2630P6 

SignMaker Dominator F121P6 

Cat 1 

Cat 1 

  

 

 

2.2 Cutting Device Drivers 

Manufacturer Device name  Category  

Summa Summa (S3 Class) Cat 0 

Vivid Laminating Technologies Ltd VeloBlade Nexus Cat 1 

 

Complete driver list on our website. Please note that drivers for Industrial Printing are not listed here. 

 

  

https://www.colorgate.com/service-support/ressourcen/supported-devices/printers/
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3 Improvements and Bugfixes 

3.1 NEW FEATURE Setup Assistant 

If the software is started and no printer is open - for example after a new installation - a setup assistant 
will now open automatically. This provides you at a glance with the most important steps for working 
with the ColorGATE software.  
 
In this way, you can quickly and easily 
- create a new printer 
- open a printer that has already been created but is currently closed 
- import the system configuration of a previous version into the current one 
- restore a previously backed up system configuration 
- go directly to more information about the setup assistant in the online help 

 

 

The "Import the system configuration from a previous version" option allows you to transfer your former 
user-defined settings (including printer definitions, program settings, job data, profiles and lineariza-
tions) directly to the new version e.g., after updating the software - without the need to manually 
backup and then restore the system configuration.  
This guarantees a smooth and fast transition between different software versions. 
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If required, you can also call up the setup assistant manually at any time by clicking on "Help" > "Setup 
assistant...". 

3.2 NEW Print Job Info as QR Code 

Job-related information can now be printed not only in text form, but also as a QR code together with 
the job. For this purpose, the "Edit Job Info" dialog (Job settings > "Job" tab > "Edit info...") has been ex-
tended to include an area for QR codes: 
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Here you can define which job-related information should be included in the QR code (e.g. the job 
name, the MIM used, the output profile, etc.), how the QR code should be aligned and what size the in-
dividual pixels of the code should have. 

3.3 General Improvements and Bugfixes 

• NEW A new MIM created from the MIM administration now contains the color settings from the first 

hotfolder. 

• NEW If Windows crash dumps are generated when creating a Support Info File, they are now stored 

in the GCLogs folder and can be viewed by clicking "Help" > "Open log folder". 

• NEW The "Window" menu has been extended and now offers three new options to  

- close all open printers  

- close the currently used printer 

- close all open printers other than the currently used one.  

This simplifies the work and operation of the software with a large number of printers. 

 

 

• NEW The regular scan of all existing active hotfolders for changes has been optimized, so that the 

performance of the software has been improved as a result. 

• NEW To support the Kala Kalaxy cutters, the cut marks "KalaXY" are now available and can be se-

lected in the "Cut Mark Settings" dialog. 
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• BUGFIX Fotoba marks were sometimes printed on the wrong position. This mostly happened with 

jobs that included a larger container. 

• BUGFIX Since version 23.01, it was not possible to create Windows crash dumps when creating a 

Support Info File. 

• BUGFIX Corrupt job files caused a crash when starting the software or changing the archive path. 

Such files are now skipped, and a system log entry is created. If the REST server is running corrupt 

files are removed automatically. 

• BUGFIX When creating a new linearization or profile, information about an already existing lineari-

zation/profile from the hotfolder was displayed in the "Edit Job Info" dialog. 

• BUGFIX In version 23.01, the software crashed under certain circumstances when trying to import 

a MIM. 

• BUGFIX If all settings for a job were loaded from a tab other than the "Job" tab, this may have re-

sulted in a RIP error. 

• BUGFIX In the Hotfolder settings, "user defined" was always displayed on the "Rip" tab.  

If "Scale 1:1" was enabled, "user defined" was also always displayed on the "Job" tab. 
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• BUGFIX Sometimes the software crashed after a color correction was done. 

• BUGFIX If the option "Fit to page" is enabled for a job and this job is sent to another hotfolder, the 

size of the job is now updated. 

Color Management: 

• NEW To illustrate that the effect of the DeviceLink exception "Pure Black" is overlaid by "Black 

Overprint", its status is now synchronized. So, if "Black Overprint" is set or cleared, the same is 

done for "Pure Black".  

In addition, the checkbox for "Pure Black" is disabled when "Black Overprint" is set to ensure that 
both options remain synchronized. 

• BUGFIX In some cases, depending on the characteristics of the output profile, the pure colors op-
tions did not work as expected on multicolor output (e.g., 6CLR). 

• BUGFIX The .eps-based targets IT874_EyeOneIsis_A4.ctx and IT874_EyeOneIsis_A3.ctx have been 

replaced by .pdf files as the previous targets were incorrect. 

• BUGFIX Droplet separation curves from special color .ccx files were not applied correctly if the file 

was created prior to V23. 

Color Replacement: 

• BUGFIX The display of special color channels was not correct if the color replacement with a spe-
cial color was deactivated. 

• BUGFIX Color tables that were marked as "deprecated" by PantoneLIVE® were not downloaded. 

File Handling: 

• BUGFIX It was not possible to export a file to the root of a hard disk. 

Licensing: 

• NEW If the software is started with a non-registered or non-activated license, a dialog will appear 

informing the user about the necessity of a product registration / activation.  

This dialog has now been made clearer and more user-friendly: The required steps are described in 

detail and the user is thus informed about what he must do to be able to use his license without 

restrictions. 
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• NEW When installing a software update, a note appears now for software-based licenses (SHL-SW) 

that a valid Value Pack must be present in order to use the software and where the validity of the 

Value Pack can be checked if required. 

• BUGFIX The update notification for NFR (Not For Resale) licenses incorrectly referred to the validi-

ty of the Value Pack contract. 

Preview: 

• NEW The Color Picker ("Show Color Information") in the advanced preview has been optimized and 

now also displays special colors. 
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• NEW The channel preview has been extended with an option for none-screen workflows to display 

all channels side by side (for screen drivers, this option was already available). 

 

 

• NEW Also channel/separation names are now shown next to the separations. 

• NEW In screen workflow, single separations can now be displayed in a large preview. 

System Backup: 

• BUGFIX Since version 23, the software sometimes crashed when trying to make a system backup. 

User Interface: 

• NEW The display and selection of color modes on the "Print Mode" tab of the Advanced Settings has 

been improved and made clearer: If more than five color modes are available, it is now possible to 

select the desired color mode from a sorted list. 
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• NEW The Ink Splitting preset names and descriptions in the Linearization and Profiling Assistant are 
now available in different languages. 

• NEW A warning sign in the printer properties now indicates if an archive folder or a hotfolder does 

not exist. This makes a misconfiguration or an unmounted network drive clearly visible. 

• NEW The image for the "About ..." dialog has been updated to look sharper on high-resolution 

screens. 

• BUGFIX When the RIP or print process was started for a job, any entries in the columns to the left 

of the "Status" column were no longer displayed. 

• BUGFIX Vertical centering did not work with specific settings. 

Websupport: 

• BUGFIX It was not possible to create web tickets directly in the software (via the menu "Help" > 

"Web tickets") if no specific printer was selected in the license (e.g., before activation or for NFR 

(Not For Resale) licenses). 

3.4 Adobe® PDF Print Engine 

Information about this function on the website.  

• NEW The Adobe PDF Print Engine has been updated to version 6.2. This ensures the highest com-
patibility with PDF files, especially if they were created with the Adobe Creative Cloud products. 

3.5 Color Atlas Module 

Information about this module on the website.  

• BUGFIX When printing the color atlas for a job that had centering enabled, the offset of the job 

was applied to the color atlas. This could result in the Color Atlas being turned even though it 

would have fit on the media width. 

https://www.colorgate.com/products/software/modules/#APPE_TECHNOLOGY
https://www.colorgate.com/products/software/modules/#COLORATLAS_1
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3.6 Color Correction Loop Module 

Information about this module on the website.  

• NEW The behavior of the Color Correction Loop Module dialogs has been changed to modeless op-

eration. This allows the user to make direct input to the user interface (e.g. pause a queue) even 

when the dialog is open. 

• BUGFIX Since version 23, the Color Correction Loop Module could not be controlled correctly via 
REST. As a result, an empty message box appeared when creating a correction. 

3.7 Computer to Screen Module 

Information about this function on the website.  

• BUGFIX When creating a multi-page container, only the first one was displayed in the preview,  

although several containers were present.  

Please note that for existing multi-page containers, the properties dialog or the container editing 
window must be opened and confirmed with OK to see all containers in the preview. 

3.8 Container 

Information about this function on the website.  

• BUGFIX The centering option had no effect when printing a multi-sheet container. 

• BUGFIX If a job was duplicated within a container, this did not increase the copy count. 

• BUGFIX Duplicating jobs within a container resulted sometimes in a distorted preview and possibly 

crashes. 

• BUGFIX Adding jobs to a container via drag & drop did not work properly. 

• BUGFIX When a container was sent from one printer to another via the "Send To" function, and the 

second printer used a different print width than the first one, the media optimized arrangement in 
the container was not updated. 

https://www.colorgate.com/de/produkte/software/module/#CCLM
https://www.colorgate.com/products/software/modules/#CTSM_1
https://www.colorgate.com/products/software/modules/?L=2#CONTAINER_1
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3.9 Cost Calculation Module 

Information about this module on the website.  

• NEW To simplify the creation of new media and inks, it is now possible to duplicate an existing en-

try. This can then be slightly modified if necessary and no longer needs to be created completely 

from scratch. 

 

 

• NEW The number of decimal digits for ink amount values shown in cost calculation dialogs and re-

ports has been increased from two to six.  
Thus, a very low ink usage value is now also displayed. 

3.10 Filmgate / Film and Plate Module 

Information about this module on the website. 
 

• NEW Only the menu items that are relevant to the Screen workflow are now displayed, making the 
program clearer.  

• BUGFIX If a color correction curve for "All channels" was configured in the hotfolder it was not ap-

plied to a new job. 

• BUGFIX MIM’s that were created from the Linearization Assistant in Screen workflow were not ini-

tialized correctly. 

• BUGFIX If color management was enabled in the Screen workflow for the hotfolder used, Produc-
tionserver crashed after the preview for separated PDFs had been created. 

• BUGFIX The popup menu to select a single plane in the separation preview was not correctly ini-
tialized for jobs with deactivated "Softproof" option. 

https://www.colorgate.com/products/software/modules/#CCM_1
https://www.colorgate.com/de/produkte/software/module/#FPM_1
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• BUGFIX When at least one plane was disabled, incorrect names of planes were show in the separa-
tion preview. 

3.11 Fingerprint Module 

Information about this module on the website.  

• NEW It is possible now to control the Fingerprint options via REST. 

• NEW To prevent errors when printing a Fingerprint Production File, the option "Use embedded pro-

files" is now enabled whenever a job is created from a Fingerprint Production File, regardless of 

the settings in the hotfolder.  

In addition, a warning is displayed on the "Profiles" tab when the "Use embedded profiles" option is 
deactivated for jobs created from a Fingerprint Production File. 

3.12 JDF Interface Module 

Information about this module on the website.  

• BUGFIX Adding regular image files to a JDF hotfolder via button or drag & drop did not work. 

3.13 Job Backup Module 

Information about this module on the website.  

• NEW The REST API now supports the Job Backup Module, so new endpoints for creating and restor-

ing job backups are available. 

• NEW When creating a backup for multiple jobs, the file name of the backup can now be edited. 

• NEW When restoring a backup, a new "Info" button can be used to display a window with all con-

tained jobs of the selected backup. 

https://www.colorgate.com/products/software/modules/#FPRM
https://www.colorgate.com/products/software/modules/#JDFM_1
https://www.colorgate.com/products/software/modules/#JBM
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• NEW Conflicts such as duplicate job names or different profiles are now shown in a separate win-

dow and are arranged more clearly. 

• NEW If the restore of a job fails, a corresponding message is now displayed. 

• BUGFIX If a backup was created for several different jobs, only the MIMs and the profiles of one 

job were stored. 

• BUGFIX When putting job backups into a hotfolder, the option "Overwrite existing jobs" did not 

work. 

3.14 Print and Cut Module 

Information about this module on the website.  

• NEW The cut label function has been enhanced with an option that attaches the label to the job 

frame with an additional cut path between job and label.  

 

 
 

In this way it is possible, for example, to add a perforation between the job and the label so that 

the label is kept with the job but at the same time it can be cut off very easily. 

 

 

https://www.colorgate.com/products/software/modules/#PCM_1
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ColorGATE CutServer: 

• BUGFIX In the preview, the cut path was partially not displayed. 

ESKO i-cut Production Console: 

• BUGFIX The cut preview was not created correctly for multi-page containers. 

GCC Puma III/Jaguar IV / GCC Puma IV/Jaguar V: 

• NEW For .plt files, decimal places are now no longer specified since they are not relevant for cut-
ting. 

IECHO-SK / Jingwei-SK: 

• NEW The drivers are able now to generate a QR code while printing a file. 

MultiCam: 

• BUGFIX The maximum segment length was not applied correctly. The additional marks were miss-

ing in the cut files. 

Mutoh (Ultima, SC-Pro, Kona) / Primera FX Series: 

• NEW For .plt files, decimal places are now no longer specified since they are not relevant for cut-

ting. 

Summa (S/S2 Class, SummaSign, SummaCut): 

• NEW For .plt files, decimal places are now no longer specified since they are not relevant for cut-
ting. 

• NEW Since version 23, the cutter sometimes recognized a motif as OPOS XY line as the distance be-

tween motif and line was too small. Now, there is a new option to set the distance between the 

mark and the job. 
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• BUGFIX Under certain circumstances, the barcode was printed although this option was not ena-
bled. 

Trotec: 

• NEW For .plt files, decimal places are now no longer specified since they are not relevant for cut-
ting. 

3.15 Profiler Module / 
Linearization Assistant 

Information about the Profiler Module here on the web-
site. 
Information about the Linearization Assistant here. 

            

• BUGFIX When creating a XCLR profile, incorrect color icons were displayed on the "Full Color 

Graphs" tab. 

• BUGFIX If a .ccx file is opened and the MIM is not found, the .ccx file is now opened read-only. 

This way it can no longer be saved to avoid writing back incomplete data. 

• BUGFIX When duplicating a MIM from the Linearization and Profiling Assistant, the simulation pro-

file was removed from the settings. 

• BUGFIX If a MIM was renamed, the MIM name in the .ccx file was not updated. This resulted in an 

error message about a missing MIM when opening the .ccx file. 

• BUGFIX Updating of hotfolder and job MIM names did not work if a MIM was renamed twice. 

• BUGFIX When creating a MIM via the Linearization and Profiling Assistant, it was not possible to se-

lect the workflow. 

• BUGFIX When importing data for profiling targets on some color modes, e.g., CMYKROGV, a wrong 

channel was used for the reference values and an error message appeared. 

• BUGFIX It was not possible to import color transfer curves (.cctx files). 

• BUGFIX When exporting measurement data for some color modes, e.g., CMYKRO, a wrong channel 

order was used for the reference values. 

https://www.colorgate.com/products/software/modules/#PFM_1
https://www.colorgate.com/products/software/modules/#LIN_ASSI_1
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Konica Minolta FD-9: 

• BUGFIX It was not possible to enter more than two digits for the IP address in the device settings 

dialog. 

TECHKON SpectroDens: 

• BUGFIX The transfer of measured values between the measuring device and the software did not 

work reliably. Now the driver checks whether the correct number of patches is transferred during a 
strip measurement. If this is not the case, the measurement of the row can be repeated. 

X-Rite i1iO for i1Pro3 & i1Pro3 Plus: 

• BUGFIX If a measurement chart was measured rotated by 180°, the results were inverted. 

X-Rite i1Pro3: 

• BUGFIX In version 23 the category of the measurement device has been changed and is now Cat 0. 

If a previous version is used with a V23 license, the driver should be available with this version, 

even if it was not part of the old license. This now also works with software based licenses. 

3.16 REST API Module 

Information about this module on the website.  

• NEW It is possible now to control the Fingerprint options via REST. 

• NEW The REST API now supports the Job Backup Module, so new endpoints for creating and restor-

ing job backups are available. 

• NEW The new endpoint 7.14. allows to retrieve the target previews as displayed in the user inter-

face. 

• NEW Corrupt files that can cause the program to crash are now automatically removed when the 

REST server is running. 

• NEW It is now allowed to send empty strings to clear settings like "freeInfo" in the job settings. 

• BUGFIX Since version 23, the Color Correction Loop Module could not be controlled correctly via 
REST. As a result, an empty message box appeared when creating a correction. 

• BUGFIX A PrintFinished notification was sometimes not sent if the job was automatically deleted. 

https://www.colorgate.com/products/software/modules/#RAM
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• BUGFIX Some PrintFinished notifications were missing when printing multiple jobs. 

• BUGFIX The workflow settings were inconsistent. To fix this, the new options  
“DeleteJobAfter1Week”, “DeleteJobAfter2Weeks” and “DeleteJobAfter4Weeks” have been added 
for the parameter "afterPrint". 

• BUGFIX Getting the setting "Workflow" > "AutoPrint" reported the setting "AutoRip". 

• BUGFIX When retrieving the job settings, the values for width and height were swapped if the job 
was rotated. Now, the values always contain the original job size as in the user interface. 

• BUGFIX Changing the "fixedSize" option for containers did not work properly. 

• BUGFIX The "Copies" field in the job list reported a wrong value for container jobs. 

• BUGFIX If a multicopy job should be added to an existing container, only a single copy was added. 

• BUGFIX The option "useMediaSize" has been added for containers. 

• BUGFIX Setting an output directory now also works with containers.  

• BUGFIX When printing a container job, the output files were not added to the files endpoint and 
the system log did not contain the "PrintPageFinished" notification. 

• BUGFIX Splitting a container led to a crash of the software if a job had a copyCount > 1. 

• BUGFIX It was not possible to remove a job if it had a copyCount > 1. 

• BUGFIX If the media height was changed, it was set to 0 and the “Rollfeed” option was activated. 

• BUGFIX The MIM administration was not updated correctly after a MIM import. 

• BUGFIX It is now possible to send a color replacement with special colors. 

• BUGFIX Setting the resolution via REST had no effect. 

• BUGFIX After aborting a rip or a print process of a job, it was not possible to restart ripping or 
printing. 

• BUGFIX If "Dynamic" was selected as media size, the control wedge was printed on the print motif. 

• BUGFIX Printing a static target file failed with a "File not found" message. 
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3.17 TVI Calibration Module 

Information about this function on the website.  

• NEW Process calibration targets for the following devices have been added: Barbieri Spectro LFP, 
X-Rite i1Pro3 Plus and X-Rite i1iO for i1Pro3 Plus. 

 

 

 

  

https://www.colorgate.com/products/software/modules/#TVICM
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3.18 Printer related 

aeoon Maikuro: 

• BUGFIX The bit depth settings have been corrected from 2 bit to 4 bit. 

Atexco Model X: 

• BUGFIX In version 23, it was not possible to print certain container jobs. 

Brother GTX-422: 

• BUGFIX The file extensions of the output files have been adjusted and now depend on the printer 

model (.arx4, .arx6, .arxp). 

• BUGFIX Files created with Productionserver can now be opened in Brother's FileViewer.  

In addition, jobs generated in Productionserver have the prefix "CG:" in their name and can thus be 

identified more easily in FileViewer. 

Brother GTX-600: 

• BUGFIX The file extensions of the output files have been adjusted and now depend on the printer 

model (.arx4, .arx6, .arxp). 

Brother GTXpro: 

• BUGFIX Automatic printing of W + C in single print head pass did not work properly. 

• BUGFIX The file extensions of the output files have been adjusted and now depend on the printer 

model (.arx4, .arx6, .arxp). 

• BUGFIX Under some circumstances, the preview was not shown on the printer panel and on the 

GTX file viewer tool. 

• BUGFIX Files created with Productionserver can now be opened in Brother's FileViewer.  

In addition, jobs generated in Productionserver have the prefix "CG:" in their name and can thus be 

identified more easily in FileViewer. 

Epson printer drivers: 

• BUGFIX Outdated error messages and other texts have been corrected and updated. 

Epson SureColor SC-P20000: 

• BUGFIX When printing in RGB-HTM mode, the output was nearly black since V23. 
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Epson SureColor SC-P65X0 (D/DM/DL) Series / SC-P85X0 Series / SC-T37X0 (D/DL/DM) Series / SC-T57X0 
Series / SC-T77X0 Series: 

• BUGFIX Borderless printing did not work when "Paper source" was set to "Roll (auto select)". 

• BUGFIX The check whether the set width is valid for borderless (full bleed) printing did not take 

place if "User defined" was selected as "Media Size". 

Guangzhou PuLisi Technology Co PuLisi-H: 

• NEW The color mode CMYKOGV is now available. 

• NEW A preview file can now be configured for path output and can be generated as .bmp file. 

Guangzhou PuLisi Technology Co PuLisi-R: 

• NEW The width limitation has been removed. 

• NEW The "Rollfeed" option has been removed. 

• NEW The height limitation has been set to 1310mm. 

• BUGFIX Changes to the supported color modes were not applied and were thus not available in the 

existing .cos files. 

GUNSJET KGT Label 510: 

• BUGFIX When a job was to be printed with a 2 bit and 1200x1200dpi print mode, it was cancelled 

with an error message. 

Kornit Atlas MAX Poly: 

• NEW Following print modes have been updated:  

- Cotton STD Neon has been removed. 

- Cotton HQ, Cotton UHQ, Cotton Light HQ, MaxPoly Cotton Light CMYK and MaxPoly Cotton Dark 

CMYK have been added. 

- Cotton JIS (formerly Cotton Neon JIS) and Cotton Light STD (formerly Cotton Light Neon) have 

been renamed. 

Mimaki CJV330 / JV330: 

• NEW The driver now has the options "Vacuum power", "Top blower strength" and "Media feed 

speed". 

Mimaki JFX-200-2513 EX: 

• BUGFIX In version 23, error command 201 was displayed when printing white and color in one pass. 
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Mimaki TxF150-75: 

• NEW The temperature limits for preheater, printheater and postheater have been changed from (0 

- 60) to (0 - 50). 

Mimaki UJF3042 MKII e / UJF6042 MKII e: 

• NEW Two new options "Head Refresh" and "Logical Seek" are now available. 

 

 

• BUGFIX White ink overprinting was not working. 

• BUGFIX When printing White > Color, the printing process was not completed. 

Mimaki UJF7151 plus II: 

• NEW The ink set "WW+6Color (LcLmMCYK)" has been added. 

• BUGFIX When printing White > Color, the printing process was not completed. 

• BUGFIX The layer combination White > Color >Varnish was missing. 

Mutoh ValueJet-628MP: 

• NEW The color modes CMYKLCLMLK and CMYKOGB have been added. 

Océ Colorado 1630 / Colorado 1640 / Colorado 1650: 

• NEW Horizontal offset is no longer handled in the ColorGATE software. This enables the printer to 

automatically place synchronization marks as close to the job as possible. 
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Ricoh Pro L5160 / Pro L5160e: 

• BUGFIX Some ink droplet sizes used for the ink usage calculation have been corrected. 

Roland BN-20: 

• BUGFIX Since V23.01, it was not possible to print and an access violation appeared. 

Roland LEC-540: 

• BUGFIX When a vertical offset should be printed and a cutter was activated before the "Rollfeed" 

option was unchecked, no vertical offset was printed. Now, the cutting is set off when the 
"Rollfeed" option is deactivated. 

Roland VG3-540 / VG3-640: 

• BUGFIX The label for the media type was missing on the "Print Mode" tab. 

• BUGFIX The heater and the dryer temperature was missing on the "Print Mode" tab. 

• BUGFIX The option "Special ink set" was shown for ink channel setups that cannot include special 

inks. 

• BUGFIX The "Combine layers" option was shown even when no special inks were active or available. 

• BUGFIX The value "User defined" for "Head height" has been replaced with "Panel". 

Roland VS-300i: 

• BUGFIX Since V23.01, the connection to the printer could not be established. 

SignMaker SM EP184CL-U: 

• NEW The driver now has the option "Print Special Colors only" on the "Print Mode" tab. 

 

 

A list of all printer drivers supported by ColorGATE can be found on our website. 

https://www.colorgate.com/service-support/ressourcen/supported-devices/printers/
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	 NEW A new MIM created from the MIM administration now contains the color settings from the first hotfolder.
	 NEW If Windows crash dumps are generated when creating a Support Info File, they are now stored in the GCLogs folder and can be viewed by clicking "Help" > "Open log folder".
	 NEW The "Window" menu has been extended and now offers three new options to  - close all open printers  - close the currently used printer - close all open printers other than the currently used one.  This simplifies the work and operation of the so...
	 NEW The regular scan of all existing active hotfolders for changes has been optimized, so that the performance of the software has been improved as a result.
	 NEW To support the Kala Kalaxy cutters, the cut marks "KalaXY" are now available and can be selected in the "Cut Mark Settings" dialog.
	 Bugfix Fotoba marks were sometimes printed on the wrong position. This mostly happened with jobs that included a larger container.
	 Bugfix Since version 23.01, it was not possible to create Windows crash dumps when creating a Support Info File.
	 Bugfix Corrupt job files caused a crash when starting the software or changing the archive path. Such files are now skipped, and a system log entry is created. If the REST server is running corrupt files are removed automatically.
	 Bugfix When creating a new linearization or profile, information about an already existing linearization/profile from the hotfolder was displayed in the "Edit Job Info" dialog.
	 Bugfix In version 23.01, the software crashed under certain circumstances when trying to import a MIM.
	 Bugfix If all settings for a job were loaded from a tab other than the "Job" tab, this may have resulted in a RIP error.
	 Bugfix In the Hotfolder settings, "user defined" was always displayed on the "Rip" tab.  If "Scale 1:1" was enabled, "user defined" was also always displayed on the "Job" tab.
	 Bugfix Sometimes the software crashed after a color correction was done.
	 Bugfix If the option "Fit to page" is enabled for a job and this job is sent to another hotfolder, the size of the job is now updated.
	 NEW To illustrate that the effect of the DeviceLink exception "Pure Black" is overlaid by "Black Overprint", its status is now synchronized. So, if "Black Overprint" is set or cleared, the same is done for "Pure Black".  In addition, the checkbox fo...
	 Bugfix In some cases, depending on the characteristics of the output profile, the pure colors options did not work as expected on multicolor output (e.g., 6CLR).
	 Bugfix The .eps-based targets IT874_EyeOneIsis_A4.ctx and IT874_EyeOneIsis_A3.ctx have been replaced by .pdf files as the previous targets were incorrect.
	 Bugfix Droplet separation curves from special color .ccx files were not applied correctly if the file was created prior to V23.
	 Bugfix The display of special color channels was not correct if the color replacement with a special color was deactivated.
	 Bugfix Color tables that were marked as "deprecated" by PantoneLIVE® were not downloaded.
	 Bugfix It was not possible to export a file to the root of a hard disk.
	 NEW If the software is started with a non-registered or non-activated license, a dialog will appear informing the user about the necessity of a product registration / activation.  This dialog has now been made clearer and more user-friendly: The req...
	 NEW When installing a software update, a note appears now for software-based licenses (SHL-SW) that a valid Value Pack must be present in order to use the software and where the validity of the Value Pack can be checked if required.
	 Bugfix The update notification for NFR (Not For Resale) licenses incorrectly referred to the validity of the Value Pack contract.
	 NEW The Color Picker ("Show Color Information") in the advanced preview has been optimized and now also displays special colors.
	 NEW The channel preview has been extended with an option for none-screen workflows to display all channels side by side (for screen drivers, this option was already available).
	 NEW Also channel/separation names are now shown next to the separations.
	 NEW In screen workflow, single separations can now be displayed in a large preview.
	 Bugfix Since version 23, the software sometimes crashed when trying to make a system backup.
	 NEW The display and selection of color modes on the "Print Mode" tab of the Advanced Settings has been improved and made clearer: If more than five color modes are available, it is now possible to select the desired color mode from a sorted list.
	 NEW The Ink Splitting preset names and descriptions in the Linearization and Profiling Assistant are now available in different languages.
	 NEW A warning sign in the printer properties now indicates if an archive folder or a hotfolder does not exist. This makes a misconfiguration or an unmounted network drive clearly visible.
	 NEW The image for the "About ..." dialog has been updated to look sharper on high-resolution screens.
	 Bugfix When the RIP or print process was started for a job, any entries in the columns to the left of the "Status" column were no longer displayed.
	 Bugfix Vertical centering did not work with specific settings.
	 Bugfix It was not possible to create web tickets directly in the software (via the menu "Help" > "Web tickets") if no specific printer was selected in the license (e.g., before activation or for NFR (Not For Resale) licenses).
	 NEW The Adobe PDF Print Engine has been updated to version 6.2. This ensures the highest compatibility with PDF files, especially if they were created with the Adobe Creative Cloud products.
	 Bugfix When printing the color atlas for a job that had centering enabled, the offset of the job was applied to the color atlas. This could result in the Color Atlas being turned even though it would have fit on the media width.
	 NEW The behavior of the Color Correction Loop Module dialogs has been changed to modeless operation. This allows the user to make direct input to the user interface (e.g. pause a queue) even when the dialog is open.
	 Bugfix Since version 23, the Color Correction Loop Module could not be controlled correctly via REST. As a result, an empty message box appeared when creating a correction.
	 Bugfix When creating a multi-page container, only the first one was displayed in the preview,  although several containers were present.  Please note that for existing multi-page containers, the properties dialog or the container editing window must...
	 Bugfix The centering option had no effect when printing a multi-sheet container.
	 Bugfix If a job was duplicated within a container, this did not increase the copy count.
	 Bugfix Duplicating jobs within a container resulted sometimes in a distorted preview and possibly crashes.
	 Bugfix Adding jobs to a container via drag & drop did not work properly.
	 Bugfix When a container was sent from one printer to another via the "Send To" function, and the second printer used a different print width than the first one, the media optimized arrangement in the container was not updated.
	 NEW To simplify the creation of new media and inks, it is now possible to duplicate an existing entry. This can then be slightly modified if necessary and no longer needs to be created completely from scratch.
	 NEW The number of decimal digits for ink amount values shown in cost calculation dialogs and reports has been increased from two to six.  Thus, a very low ink usage value is now also displayed.
	 NEW Only the menu items that are relevant to the Screen workflow are now displayed, making the program clearer.
	 Bugfix If a color correction curve for "All channels" was configured in the hotfolder it was not applied to a new job.
	 Bugfix MIM’s that were created from the Linearization Assistant in Screen workflow were not initialized correctly.
	 Bugfix If color management was enabled in the Screen workflow for the hotfolder used, Productionserver crashed after the preview for separated PDFs had been created.
	 Bugfix The popup menu to select a single plane in the separation preview was not correctly initialized for jobs with deactivated "Softproof" option.
	 Bugfix When at least one plane was disabled, incorrect names of planes were show in the separation preview.
	 NEW It is possible now to control the Fingerprint options via REST.
	 NEW To prevent errors when printing a Fingerprint Production File, the option "Use embedded profiles" is now enabled whenever a job is created from a Fingerprint Production File, regardless of the settings in the hotfolder.  In addition, a warning i...
	 Bugfix Adding regular image files to a JDF hotfolder via button or drag & drop did not work.
	 NEW The REST API now supports the Job Backup Module, so new endpoints for creating and restoring job backups are available.
	 NEW When creating a backup for multiple jobs, the file name of the backup can now be edited.
	 NEW When restoring a backup, a new "Info" button can be used to display a window with all contained jobs of the selected backup.
	 NEW Conflicts such as duplicate job names or different profiles are now shown in a separate window and are arranged more clearly.
	 NEW If the restore of a job fails, a corresponding message is now displayed.
	 Bugfix If a backup was created for several different jobs, only the MIMs and the profiles of one job were stored.
	 Bugfix When putting job backups into a hotfolder, the option "Overwrite existing jobs" did not work.
	 NEW The cut label function has been enhanced with an option that attaches the label to the job frame with an additional cut path between job and label.     In this way it is possible, for example, to add a perforation between the job and the label s...
	 Bugfix In the preview, the cut path was partially not displayed.
	 Bugfix The cut preview was not created correctly for multi-page containers.
	 NEW For .plt files, decimal places are now no longer specified since they are not relevant for cutting.
	 NEW The drivers are able now to generate a QR code while printing a file.
	 Bugfix The maximum segment length was not applied correctly. The additional marks were missing in the cut files.
	 NEW For .plt files, decimal places are now no longer specified since they are not relevant for cutting.
	 NEW For .plt files, decimal places are now no longer specified since they are not relevant for cutting.
	 NEW Since version 23, the cutter sometimes recognized a motif as OPOS XY line as the distance between motif and line was too small. Now, there is a new option to set the distance between the mark and the job.
	 Bugfix Under certain circumstances, the barcode was printed although this option was not enabled.
	 NEW For .plt files, decimal places are now no longer specified since they are not relevant for cutting.
	 Bugfix When creating a XCLR profile, incorrect color icons were displayed on the "Full Color Graphs" tab.
	 Bugfix If a .ccx file is opened and the MIM is not found, the .ccx file is now opened read-only. This way it can no longer be saved to avoid writing back incomplete data.
	 Bugfix When duplicating a MIM from the Linearization and Profiling Assistant, the simulation profile was removed from the settings.
	 Bugfix If a MIM was renamed, the MIM name in the .ccx file was not updated. This resulted in an error message about a missing MIM when opening the .ccx file.
	 Bugfix Updating of hotfolder and job MIM names did not work if a MIM was renamed twice.
	 Bugfix When creating a MIM via the Linearization and Profiling Assistant, it was not possible to select the workflow.
	 Bugfix When importing data for profiling targets on some color modes, e.g., CMYKROGV, a wrong channel was used for the reference values and an error message appeared.
	 Bugfix It was not possible to import color transfer curves (.cctx files).
	 Bugfix When exporting measurement data for some color modes, e.g., CMYKRO, a wrong channel order was used for the reference values.
	 Bugfix It was not possible to enter more than two digits for the IP address in the device settings dialog.
	 Bugfix The transfer of measured values between the measuring device and the software did not work reliably. Now the driver checks whether the correct number of patches is transferred during a strip measurement. If this is not the case, the measureme...
	 Bugfix If a measurement chart was measured rotated by 180 , the results were inverted.
	 Bugfix In version 23 the category of the measurement device has been changed and is now Cat 0. If a previous version is used with a V23 license, the driver should be available with this version, even if it was not part of the old license. This now a...
	 NEW It is possible now to control the Fingerprint options via REST.
	 NEW The REST API now supports the Job Backup Module, so new endpoints for creating and restoring job backups are available.
	 NEW The new endpoint 7.14. allows to retrieve the target previews as displayed in the user interface.
	 NEW Corrupt files that can cause the program to crash are now automatically removed when the REST server is running.
	 NEW It is now allowed to send empty strings to clear settings like "freeInfo" in the job settings.
	 Bugfix Since version 23, the Color Correction Loop Module could not be controlled correctly via REST. As a result, an empty message box appeared when creating a correction.
	 Bugfix A PrintFinished notification was sometimes not sent if the job was automatically deleted.
	 Bugfix Some PrintFinished notifications were missing when printing multiple jobs.
	 Bugfix The workflow settings were inconsistent. To fix this, the new options  “DeleteJobAfter1Week”, “DeleteJobAfter2Weeks” and “DeleteJobAfter4Weeks” have been added for the parameter "afterPrint".
	 Bugfix Getting the setting "Workflow" > "AutoPrint" reported the setting "AutoRip".
	 Bugfix When retrieving the job settings, the values for width and height were swapped if the job was rotated. Now, the values always contain the original job size as in the user interface.
	 Bugfix Changing the "fixedSize" option for containers did not work properly.
	 Bugfix The "Copies" field in the job list reported a wrong value for container jobs.
	 Bugfix If a multicopy job should be added to an existing container, only a single copy was added.
	 Bugfix The option "useMediaSize" has been added for containers.
	 Bugfix Setting an output directory now also works with containers.
	 Bugfix When printing a container job, the output files were not added to the files endpoint and the system log did not contain the "PrintPageFinished" notification.
	 Bugfix Splitting a container led to a crash of the software if a job had a copyCount > 1.
	 Bugfix It was not possible to remove a job if it had a copyCount > 1.
	 Bugfix If the media height was changed, it was set to 0 and the “Rollfeed” option was activated.
	 Bugfix The MIM administration was not updated correctly after a MIM import.
	 Bugfix It is now possible to send a color replacement with special colors.
	 Bugfix Setting the resolution via REST had no effect.
	 Bugfix After aborting a rip or a print process of a job, it was not possible to restart ripping or printing.
	 Bugfix If "Dynamic" was selected as media size, the control wedge was printed on the print motif.
	 Bugfix Printing a static target file failed with a "File not found" message.
	 NEW Process calibration targets for the following devices have been added: Barbieri Spectro LFP, X-Rite i1Pro3 Plus and X-Rite i1iO for i1Pro3 Plus.
	3.18 Printer related
	 Bugfix The bit depth settings have been corrected from 2 bit to 4 bit.
	 Bugfix In version 23, it was not possible to print certain container jobs.
	 Bugfix The file extensions of the output files have been adjusted and now depend on the printer model (.arx4, .arx6, .arxp).
	 Bugfix Files created with Productionserver can now be opened in Brother's FileViewer.  In addition, jobs generated in Productionserver have the prefix "CG:" in their name and can thus be identified more easily in FileViewer.
	 Bugfix The file extensions of the output files have been adjusted and now depend on the printer model (.arx4, .arx6, .arxp).
	 Bugfix Automatic printing of W + C in single print head pass did not work properly.
	 Bugfix The file extensions of the output files have been adjusted and now depend on the printer model (.arx4, .arx6, .arxp).
	 Bugfix Under some circumstances, the preview was not shown on the printer panel and on the GTX file viewer tool.
	 Bugfix Files created with Productionserver can now be opened in Brother's FileViewer.  In addition, jobs generated in Productionserver have the prefix "CG:" in their name and can thus be identified more easily in FileViewer.
	 Bugfix Outdated error messages and other texts have been corrected and updated.
	 Bugfix When printing in RGB-HTM mode, the output was nearly black since V23.
	 Bugfix Borderless printing did not work when "Paper source" was set to "Roll (auto select)".
	 Bugfix The check whether the set width is valid for borderless (full bleed) printing did not take place if "User defined" was selected as "Media Size".
	 NEW The color mode CMYKOGV is now available.
	 NEW A preview file can now be configured for path output and can be generated as .bmp file.
	 NEW The width limitation has been removed.
	 NEW The "Rollfeed" option has been removed.
	 NEW The height limitation has been set to 1310mm.
	 Bugfix Changes to the supported color modes were not applied and were thus not available in the existing .cos files.
	 Bugfix When a job was to be printed with a 2 bit and 1200x1200dpi print mode, it was cancelled with an error message.
	 NEW Following print modes have been updated:  - Cotton STD Neon has been removed. - Cotton HQ, Cotton UHQ, Cotton Light HQ, MaxPoly Cotton Light CMYK and MaxPoly Cotton Dark CMYK have been added. - Cotton JIS (formerly Cotton Neon JIS) and Cotton Li...
	 NEW The driver now has the options "Vacuum power", "Top blower strength" and "Media feed speed".
	 Bugfix In version 23, error command 201 was displayed when printing white and color in one pass.
	 NEW The temperature limits for preheater, printheater and postheater have been changed from (0 - 60) to (0 - 50).
	 NEW Two new options "Head Refresh" and "Logical Seek" are now available.
	 Bugfix White ink overprinting was not working.
	 Bugfix When printing White > Color, the printing process was not completed.
	 NEW The ink set "WW+6Color (LcLmMCYK)" has been added.
	 Bugfix When printing White > Color, the printing process was not completed.
	 Bugfix The layer combination White > Color >Varnish was missing.
	 NEW The color modes CMYKLCLMLK and CMYKOGB have been added.
	 NEW Horizontal offset is no longer handled in the ColorGATE software. This enables the printer to automatically place synchronization marks as close to the job as possible.
	 Bugfix Some ink droplet sizes used for the ink usage calculation have been corrected.
	 Bugfix Since V23.01, it was not possible to print and an access violation appeared.
	 Bugfix When a vertical offset should be printed and a cutter was activated before the "Rollfeed" option was unchecked, no vertical offset was printed. Now, the cutting is set off when the "Rollfeed" option is deactivated.
	 Bugfix The label for the media type was missing on the "Print Mode" tab.
	 Bugfix The heater and the dryer temperature was missing on the "Print Mode" tab.
	 Bugfix The option "Special ink set" was shown for ink channel setups that cannot include special inks.
	 Bugfix The "Combine layers" option was shown even when no special inks were active or available.
	 Bugfix The value "User defined" for "Head height" has been replaced with "Panel".
	 Bugfix Since V23.01, the connection to the printer could not be established.
	 NEW The driver now has the option "Print Special Colors only" on the "Print Mode" tab.


